Everything you need to know about Cox Business Internet service.
Dear Customer:

Thank you for choosing Cox Business Internet™ provided by Cox Business.

This booklet covers everything you need to know about your Cox Business Internet service. From setup and configuration to troubleshooting and contact information, it’s a handy reference guide you can use to keep your Internet service working as hard as you are.

Now, whether you’re involved in hosting websites, uploading or downloading data files, teleworking or any other multiple uses, you’ll be doing so with the utmost ease, speed and confidence. You can count on Cox Business because we own and manage a nationwide network combining thousands of route miles of fiber-optic cable with self-healing architecture. By monitoring our system 24 hours a day, 365 days a year, we can ensure your Cox Business Internet service delivers as promised.

To get started, just follow the step-by-step instructions in this book. As you’re working through the setup, you’ll need the Account Information sheet provided to you in your Cox Business Welcome Kit, so be sure to have it handy. This booklet also contains answers to frequently asked questions, information for setting up Cox Business Email, technical support and troubleshooting basics, among others, so after you’ve set up Cox Business Internet, keep this booklet handy for future reference.

Did you know as a CBI Customer you may have access to Cox Business Online Backup and Cox Business Security Suite? To activate and use both features please visit our online customer account portal, My Account, at myaccount.coxbusiness.com.

To speak to your local Cox Business representative, call us at the number for your area listed below. Or visit Customer Support online at support.coxbusiness.com for additional information and helpful hints.

| AR – Arkansas       | 800-620-6196 |
| AZ – Phoenix       | 623-322-2000 |
| AZ – Tucson        | 800-929-5118 |
| CA – Orange County | 949-546-2020 |
| CA – Palos Verdes  | 949-546-2020 |
| CA – San Diego     | 619-269-2000 |
| CA – Santa Barbara | 805-683-0059 |
| CT – Manchester    | 860-432-6000 |
| FL – Gainesville/Ocala | 866-272-5777 |
| FL – Pensacola/Ft. Walton Beach | 850-796-0394 |
| GA – Macon         | 478-784-5131 |
| IA – Council Bluffs| 402-934-6000 |
| ID – Sun Valley    | 800-490-9604 |
| KS – Kansas        | 800-620-6196 |
| LA – Baton Rouge   | 225-615-2000 |
| LA – Greater Louisiana | 800-490-9604 |
| LA – New Orleans   | 504-304-1700 |
| NE – Omaha         | 402-934-6000 |
| NV – Las Vegas     | 702-507-2000 |
| OH – Cleveland     | 216-535-3344 |
| OK – Oklahoma City | 405-600-6333 |
| OK – Tulsa         | 405-600-6333 |
| RI – Rhode Island  | 401-383-6100 |
| VA – Fredericksburg and surrounding area | 866-811-4400 |
| VA – Hampton Roads | 757-369-6500 |
| VA – Northern Virginia | 703-378-0882 |
| VA – Roanoke       | 540-777-7373 |
# COX BUSINESS INTERNET™

## TABLE OF CONTENTS

**TCP/IP CONFIGURATION GUIDE** .................................................. 6

Instructions for Static and Dynamic IP setup are included under each operating system section.

- Windows XP Setup and Configuration ......................................... 9
- Windows Vista™ Setup and Configuration ...................................... 10
- Windows 7 Setup and Configuration ........................................... 14
- Mac OS 10.x Setup and Configuration ......................................... 17

**SETTING UP AND USING COX BUSINESS EMAIL** ............................. 20

- About Cox Business Email ..................................................... 20
- Logging Into Cox Business Email ............................................. 20
- Reading Messages ..................................................................... 21
- Sending Email Using the Cox Business Email Web Interface ....... 21
- Forwarding a Message ............................................................. 23
- Replying to a Message ............................................................. 23
- Trash Folder Retention ............................................................ 23
- Spam Folder Retention ............................................................. 23
- To Change Your Password ....................................................... 23
- Password Guidelines ............................................................... 24
- Create Additional Mailboxes ..................................................... 25
- Preferences: General Email Preferences .................................... 26
- Save Outgoing Messages .......................................................... 26
- HTML Privacy Protection ......................................................... 27
- Automatic Spell Check ............................................................. 27
- Return Receipts ................................................................. 28
- Account Settings ................................................................. 29
- Email Signatures ................................................................. 29
- Message Filters ................................................................. 30
- Vacation Messages ............................................................... 31
- Mail Forwarding ................................................................. 32
TCP/IP CONFIGURATION GUIDE

This section describes the network and Internet-related information you’ll need to set up and maintain your Cox Business Internet service. To properly configure your system, you’ll need the information included in the Account Information sheet, provided in your Welcome Kit, during the initial setup or if you ever replace your computer or reinstall the operating system or network router. Be sure to keep it in a safe place.

All Static and Dynamic IP* setup configurations included in this guide are for a single computer connected directly to the cable modem or a simple LAN connection. If your needs are more complex, please consult your IT manager before proceeding.

If you need additional guidelines or if you’re simply looking for helpful hints, be sure to check out support.coxbusiness.com. And be sure to check back often as we are frequently updating the site.

On the following pages are instructions for verifying and installing the required components in Microsoft Windows XP, Vista, 7 as well as Mac 10.x.

WINDOWS XP SETUP AND CONFIGURATION
For Cox Business Internet, the following networking components need to be installed along with Windows on your computer: Client for Microsoft Networks and TCP/IP Protocol software. If these components are not already installed on your computer, refer to your Windows installation CD for installation instructions.

If you are using a router, you should not be configuring your Cox provided static IP address using these instructions, but should enter the static IP information into your router following the router’s user guide instructions.

STEP 1
Click Start, select Control Panel then double click the Network Connections icon.

STEP 2
Right click the Local Area Connection icon. Select Properties.
STEP 3
Select the General tab of Internet Protocol (TCP/IP) Properties window.

Please continue on to Step 4 for either Static IP setup or Dynamic IP setup.

Static IP Setup Instructions
In this section you will need your specific Subnet Mask, Default Gateway, Primary/Preferred DNS Server, and Secondary/Alternate DNS server information included in the Account Information sheet, provided in your Welcome Kit. Please be sure to enter the addresses exactly as they appear in your documentation.

STEP 4-Static
Under Internet Protocol (TCP/IP) Properties screen under General tab, select the following:

- Select Use the following IP address.
- Type in the static IP address assigned to you in the IP Address field.
- Type in your Subnet Mask and gateway listed on your Account Information sheet.
- In Default gateway, type in your gateway address from your Account Information sheet.

STEP 5-Static
Next, select Use the following DNS server addresses. In the Preferred DNS server and Alternate DNS server fields, type in the DNS server addresses listed on the Account Information sheet (DNS addresses can be found on p. 34).

STEP 6-Static
Click on OK and then OK/Close, and that’s it.
Dynamic IP Setup Instructions

STEP 4-Dynamic
Make sure the buttons for **Obtain an IP address automatically** and **Obtain DNS server address automatically** are both selected.

STEP 5-Dynamic
Select the **Alternate Configuration** tab and make sure **Automatic Private IP address** is selected.

STEP 6-Dynamic
Select the **General** tab again and click the **Advanced** button.

STEP 7-Dynamic
In the **Advanced TCP/IP Settings** window, the **IP Settings** tab should have **DHCP Enabled** listed in the IP address section, nothing in the Default gateways section, and **Automatic metric** checked.
STEP 8-Dynamic
Select the DNS tab and make sure the Append primary and connection specific DNS suffixes and Register this connection’s address in DNS are both selected. The rest should be blank.

STEP 9-Dynamic
Select the WINS tab. Enable LMHOSTS lookup should be checked and Default should be selected in the NetBIOS setting section. You do not need to set anything under the Options tab. Click OK.

STEP 10-Dynamic
Restart your computer. When the computer boots up, the connection should be established. If not, choose Start, Control Panel, Network Settings. Right mouse-click the Local Area Connection icon and choose Enable. An enabled connection should appear as in the illustration.

*Dynamic IPs not available in all markets.
For Cox Business Internet, the following networking components need to be installed along with Windows on your computer: Client for Microsoft Networks and TCP/IP Protocol software. If these components are not already installed on your computer, refer to your Windows installation CD for installation instructions.

If you are using a router, you should not be configuring your Cox provided static IP address using these instructions, but should enter the static IP information into your router following the router’s user guide instructions.

To set up the TCP/IP configuration from the desktop:

**NOTE:** To perform the following action, you must be logged into Administrative user mode and have access to the Administrator password in case you are prompted for it.

**STEP 1**
From the **Start** menu, right-click **Network**, then click **Properties**. The **Network and Sharing Center** is now displayed.

**STEP 2**
Under **Tasks** located on the left-hand side of the window, click **Manage network connections**. The **Network Connections** window is now displayed.

**STEP 3**
Right click on the correct **Local Area Connection**, then click **Properties**. **Windows needs your permission to continue**. A pop-up window will display. Click **Continue** to open the **Local Area Connection Properties** window.
STEP 4

For Static IP setup, please continue on to Step 5-Static below. For Dynamic IP setup, please skip to page 12 to continue on to Step 5-Dynamic.

Static IP Setup Instructions
In this section you will need your specific Subnet Mask, Default Gateway, Primary/Preferred DNS Server, and Secondary/Alternative DNS server information included in the Account Information sheet, provided in your Welcome Kit. Please be sure to enter the addresses exactly as they appear in your documentation.

STEP 5-Static
Under Internet Protocol (TCP/IP) Properties screen under General tab, select the following:

• Select Use the following IP address.
• Type in the static IP address assigned to you in the IP Address field.
• Type in your Subnet Mask and gateway listed on your Account Information sheet.
• In Default gateway, type in your gateway address from your Account Information sheet.

STEP 6-Static
Next, select the Use the following DNS server addresses radio button. In the Preferred DNS server and Alternate DNS server fields, type in the DNS server addresses listed on the Account Information sheet. (DNS addresses can be found on p. 34.)

STEP 7-Static
Click on OK and then OK/Close, and that’s it.
Dynamic IP Setup Instructions

STEP 5-Dynamic
Under Internet Protocol (TCP/IP) Properties:
• From the General tab, verify that Obtain an IP address automatically and Obtain DNS server address automatically are selected.
• Click the Advanced button.

STEP 6-Dynamic
Click the IP Settings tab and verify the following:
• Under IP addresses, DHCP Enabled is listed.
• Under Default gateways, nothing is listed.
• Automatic metric is checked.

STEP 7-Dynamic
Click the DNS tab and verify the following:
• The DNS server addresses box is empty.
• Append primary and connection specific DNS suffixes is selected.
• Append parent suffixes of the primary DNS suffix is checked.
• Register this connection’s addresses in DNS is checked.
• Append these DNS suffixes (in order) is not selected.
STEP 8-Dynamic
Click the WINS tab and verify the following:
- The WINS addresses box is empty.
- Enable LMHOSTS lookup is checked.
- Default: Use NetBIOS setting from the DHCP server is selected.

STEP 9-Dynamic
Click OK to close the Advanced TCP/IP Settings window.

STEP 10-Dynamic
Click the Alternate Configuration tab and verify that Automatic private IP address is selected.

STEP 11-Dynamic
Click OK to close the Internet Protocol Version 4 (TCP/IPv4) Properties window.

NOTE: You will be prompted to restart the computer.

STEP 12-Dynamic
Click Close to close the Local Area Connection Properties window.

*Dynamic IPs not available in all markets.
For Cox Business Internet, the following networking components need to be installed along with Windows on your computer: Client for Microsoft Networks and TCP/IP Protocol software. If these components are not already installed on your computer, refer to your Windows installation CD for installation instructions.

If you are using a router, you should not be configuring your Cox provided static IP address using these instructions, but should enter the static IP information into your router following the router's user guide instructions.

To set up the TCP/IP configuration from the desktop:

**STEP 1**
From the Start menu, right-click Network, then select Properties.

**STEP 2**
On the left-hand side of the window, click the Change adapter settings link.

**STEP 3**
Right click on the correct Local Area Connection, then select Properties.

**STEP 4**
Select Internet Protocol Version 4 (TCP/IPv4), then click the Properties button.
Static IP Setup Instructions

In this section you will need your specific Subnet Mask, Default Gateway, Primary/Preferred DNS Server, and Secondary/Alternative DNS server information included in the Account Information sheet, provided in your Welcome Kit. Please be sure to enter the addresses exactly as they appear in your documentation.

STEP 5-Static
Under Internet Protocol (TCP/IP) Properties screen under General tab, select the following:
• First, select Use the following IP address.
• Type in the static IP address assigned to you in the IP Address field.
• Type in your Subnet Mask and gateway listed on your Account Information sheet.
• In Default gateway, type in your gateway address from your Account Information sheet.

STEP 6-Static
Next, select the Use the following DNS server addresses radio button. In the Preferred DNS server and Alternate DNS server fields, type in the DNS server addresses listed on the Account Information sheet (DNS addresses can be found on p. 34).

STEP 7-Static
Click on the OK button and then the OK/Close button, and that’s it.

Dynamic IP Setup Instructions

STEP 5-Dynamic
From the General tab, verify that Obtain an IP address automatically and Obtain DNS server address automatically are selected. Click the Advanced button.
STEP 6-Dynamic
From the IP Settings tab, verify the following:
• Under IP addresses, **DHCP Enabled** is listed.
• Under Default gateways, nothing is listed.
• **Automatic metric** is checked.

STEP 7-Dynamic
From the DNS tab, verify the following:
• The **DNS server addresses** box is empty.
• **Append primary and connection specific DNS suffixes** is selected.
• **Append parent suffixes of the primary DNS suffix** is checked.
• **Register this connection’s addresses in DNS** is checked.
• **Append these DNS suffixes (in order)** is not selected.

STEP 8-Dynamic
From the WINS tab, verify the following:
• The **WINS addresses** box is empty.
• **Enable LMHOSTS lookup** is checked.
• **Default: Use NetBIOS setting from the DHCP server** is selected.

STEP 9-Dynamic
Click the **OK** button to close the **Advanced TCP/IP Settings** window.

STEP 10-Dynamic
From the **Alternate Configuration** tab, verify that **Automatic private IP address** is selected.
STEP 11-Dynamic
Click the OK button to close the Internet Protocol Version 4 (TCP/IPv4) Properties window.

NOTE: You will be prompted to restart the computer.

STEP 12-Dynamic
Click the OK button to close the Local Area Connection Properties window.

MAC OS 10.x SETUP AND CONFIGURATION
If you are using a router, you should not be configuring your Cox provided static IP address using these instructions, but should enter the static IP information into your router following the router’s user guide instructions.

To set up the TCP/IP configuration from the desktop:

STEP 1
From System Preferences select Network from the Internet & Network row.

STEP 2
Under Network, disable the Lock in the lower left-hand corner by clicking on it. You might be prompted for your Admin password depending on your setup. Next, click on Built-in Ethernet and click Configure.

*Dynamic IPs not available in all markets.
STEP 3
In the drop down for Show select Build-in Ethernet. Select TCP/IP tab.

For Static IP setup, please continue on to Step 4-Static below. For Dynamic IP setup, please skip to page 19 to continue on to Step 4-Dynamic.

Static IP Setup Instructions
In this section you will need your specific Subnet Mask, Default Gateway, Primary/Preferred DNS Server, and Secondary/Alternate DNS server information included in the Account Information sheet, provided in your Welcome Kit. Please be sure to enter the addresses exactly as they appear in your documentation.

STEP 4-Static
For Configure IPv4 select Manually.

STEP 5-Static
In the IP Address box enter your assigned IP address from your Account Information sheet.

STEP 6-Static
In the Subnet Mask box enter your assigned Subnet Mask from your Account Information sheet.

STEP 7-Static
In the Router address box enter your assigned Gateway IP Address from your Account Information sheet.

STEP 8-Static
In the DNS Servers box enter your Primary DNS address followed by your Secondary DNS address (DNS addresses can be found on p. 34).

STEP 9-Static
Close and save your changes and that’s it!
Dynamic IP Setup Instructions

STEP 4-Dynamic
In the Configure field under the TCP/IP tab, highlight Using DHCP.

STEP 5-Dynamic
Next, choose Apply Now, if this option is available.

STEP 6-Dynamic
On the toolbar, choose System Preferences. Then, choose Quit System Preferences, and your setup is complete.
SETTING UP AND USING COX BUSINESS EMAIL

ABOUT COX BUSINESS EMAIL
With Cox Business Email, users can access their Email account and all of its functions, from any computer with Internet access. Our Email web interface does not require any software downloads or configuring. It’s as simple as pointing any web browser to http://email.coxbusiness.com and entering a user name and password.

LOGGING INTO COX BUSINESS EMAIL

STEP 1
Type in your full Email address and press the Tab key.
Ex: you@yourdomainname.com or you@company.coxmail.com

STEP 2
Type in your password and click the Enter button. The Inbox screen will appear.

Passwords used to sign in to Cox Business Email or account services must meet all of the following requirements:

- Contain at least eight characters (or more)
- Contain at least one number and one letter
- Not contain any form of the word “password”
- Not contain any form of your Email address or Cox login User ID

Hackers have a difficult time breaking or stealing passwords that have the following characteristics:

- Is lengthy, for example between 15 and 24 characters long
- Contain at least one symbol or special character, such as the following: !@#$%^&*()]
- Contain case-sensitive lettering, such as SaMple4 rather than sample4
- Not contain alphabetic series, either forwards or backwards, such as ABCDEF or FEDCBA
- Not contain numeric series, either forwards or backwards, such as 123456 or 654321
- Not contain a string of all identical letters or numbers, such as AAAAAA or 111111
- Not contain your spouse’s name or your birthday
- Creating an easy-to-remember pass phrase
A pass phrase is a sentence that you can remember, such as “You can’t teach an old dog new tricks.” Use the first letter of each word of the sentence in your password. In this example your password would contain “yctaodnt.” Then add a numeral, special character, and capitalization, to 4yCTaodnT!.

READING MESSAGES
Clicking on a message allows the contents to be seen in the message preview area. Additional messages are previewed by using the keyboard up and down arrow keys or by clicking on a different message in the list.

There are a number of ways to open a message:
• Double click the message
• Right click and select the Open option in the menu
• Select the message and press the Enter key

After opening a message, the entire message displays in a separate window.

SENDING EMAIL USING THE COX BUSINESS EMAIL WEB INTERFACE

STEP 1
Click the New button and the New Message window displays.

STEP 2
Email addresses can be added using several options:
1. Type the recipient’s Email address in the To: field.
2. Open the CONTACTS list by clicking on the contacts button in the upper right corner. Right click on the contact and select To, or drag and drop the contact from the contact list into the desired address field.
3. Click the Show CC:/BCC: button in the upper right corner to open the carbon copy or blind, carbon copy fields. Follow step 1 or 2 to enter desired contacts.

STEP 3
Type in the subject of the email and type the text of your message in the large textbox.
NOTE: Cox Business Email will log you out of your account after 30 minutes of inactivity. You will lose any unsaved Email drafts if this happens.

STEP 4
Attachments can be added to messages.

To include a file with the message, click the Attach button. The Select file(s) to upload window opens. Select Look In, and browse to find desired destination file. Highlight the file by clicking on it and then click the Open button.

The name and size of the attachment displays in the Attachments field.

NOTE: There are no limits to the number of attachments, but the total size of an Email and its attachments cannot exceed 30MB.

STEP 5
Another very useful feature is spell check.

A spell check can be performed by clicking the Spell Check button in the message composition toolbar.

If desired, Spell Check can be configured to automatically review all outgoing messages in the Preferences area.

Spelling errors can be corrected or ignored by clicking the corresponding Replace or Ignore button. When Spell Check is complete, select Done.

STEP 6
A copy of the message can be stored in the Sent folder by clicking the Save in Sent folder checkbox.

The Save in Sent folder can be enabled by default in Preferences. When selected, all outgoing messages are automatically saved in the Sent folder.
Click the Send button for your recipients to receive the message.

FORWARDING A MESSAGE
There are a number of ways to forward a message including the following:

- Click the Forward button in the Email menu for the selected message.
- Right click on the message and then select one of the forward options from the list.

After clicking Forward, additional text can be added to the original message, if desired. Then, click the Send button.

REPLYING TO A MESSAGE
After clicking the Reply button, the Email composition window opens.

The sender’s Email address, subject, and original message are included when replying to a message.

To reply, enter a response in the body of the Email composition window and click Send. The Email composition window closes when the message is sent.

TRASH FOLDER RETENTION
Messages that remain in the Cox Business Email Trash folder for 30 days will be deleted automatically. A message in the Trash folder may be retained by downloading it with a mail client or moving it to an alternative folder.

SPAM FOLDER RETENTION
Messages that remain in the web interface Spam folder for 21 days will be deleted automatically. A message in the Trash folder may be retained by downloading it with a mail client or moving it to an alternative folder.

TO CHANGE YOUR PASSWORD

STEP 1
Click on the Preference button in the upper right corner of the screen.

STEP 2
Click on your Email address.
STEP 3
Scroll to the password section and then click on the **Change Password** button.

STEP 4
Type your current password in the **Current Password** box. Asterisks (***)) will show in this box as you type to help keep your password confidential.

**NOTE:** If you mouse over the **white question mark** in the blue circle you will be reminded of the password guidelines.

STEP 5
Type your new password in the box labeled **New Password**, then again in the **Repeat New Password** box below it.

STEP 6
Click the **Confirm** button to complete the password update.

**NOTE:** Remember to add this newly changed password to any Email program you also use to receive Email.

**PASSWORD GUIDELINES**
Your password is the key to your Cox Business Email account. These tips will make it difficult for others to guess your password and help to keep your account secure.

**IMPORTANT:** Keep in mind, Cox employees will **never** ask you for your password.

When creating a password, do not use any combination of consecutive numbers or letters such as “12345678,” “lmnopqrs,” or adjacent letters on your keyboard such as “werty.” Also do not use for passwords, words or dates that are easily guessed, such as account login names, your spouse’s name, or your birthday. Hackers use sophisticated tools that can rapidly guess passwords based on words in the dictionary in different languages, even common words spelled backwards. There are a few guidelines you can use to ensure that your password is secure.
A secure password should:
• Contain at least eight characters.
• Contain at least one symbol or number.
• Consist of a combination of lower- and uppercase letters (for example, IsDIMs).
• Another idea is to use a passphrase. A passphrase is a sentence that you can remember, such as “You can’t teach an old dog new tricks.” Use the first letter of each word of the sentence. In this example your password would be “yctaodnt.”

A good password should not:
• Be an alphabetic series either forwards or backwards (such as, ABCDEF or FEDCBA).
• Be a numeric series, either forwards or backwards (such as, 123456 or 654321).
• Be a string of all identical letters or numbers (such as, AAAAAA or 111111).
• Be a common keyboard shortcut (such as, ASDFG or QWERTY).
• Be an easily guessed word such as your name, User ID, PID, or any variation thereof (backwards, changing case).
• Be a word(s) referring to anything noticeable about you, such as the name of your spouse, child, pet, or favorite sports team.
• Be a word that appears in a dictionary.

In addition to these guidelines, be sure to keep your passwords secret, to monitor your accounts, and to change your passwords often.

CREATE ADDITIONAL MAILBOXES

STEP 1
To set up an additional account, click the Preferences link. Within the Mail Preferences window is an Add Account button. Select this to open the Connecting To your Account page.

STEP 2
To add an account, enter the additional account information in the Email Address and Password fields. Then, select Account Type POP or IMAP. POP is the recommended incoming mail server for customers who will mainly use a mail client like Outlook, Windows Live Mail and Apple Mail. For the use a smartphone such as a Blackberry, an iPhone, or an Android phone to send and receive mail, then IMAP should be used. For smart (mobile) phone configuration, please visit support.coxbusiness.com and select Data Support and click on Email.
STEP 3
Enter the **Incoming Server Name** field on the Incoming **Mail Settings** page. The **Port** number is added automatically depending on the **Secure Connection** button selection. Click **Continue** to test the server connection.

**POP:** Incoming Mail Server: pop.coxmail.com, Port 995
**IMAP:** Incoming Mail Server: imap.coxmail.com, Port 993
Outgoing Mail Server: smtp.coxmail.com, Port 465 (for POP and IMAP)

STEP 4
The **Testing Connection** message will open. When complete, the **Connection Successful** page will include the **Account Name**, **Real Name** and a **Reply to Address** option. The **Leave Messages on the Server** checkbox is selected by default. Once settings are complete, click the **Save** button.

STEP 5
After clicking the **Save** button, the **Mail Preferences** page displays details about the additional account including:

- Account Type
- Account Name
- Account Email
- Real Name
- Reply-To Address
- Leave Messages on the Server

STEP 6
Click on **Close** to exit.

PREFERENCES: GENERAL EMAIL PREFERENCES

SAVE OUTGOING MESSAGES
Complete the following steps to automatically save sent messages to the **Sent Mail** folder in **Enhanced WebMail**.

STEP 1
From the **Inbox** window, click the **Preferences** link.
STEP 2
From the **General Email Preferences**, check the **Save all outgoing messages to your “Sent Mail” folder** box.

STEP 3
Click the **Save** button.

STEP 4
Click the **Close** button.

**HTML PRIVACY PROTECTION**
The HTML Privacy Protection setting on the Preferences page provides an option for blocking these external images, so they do not display. Instead, a Blocked Images message will display where the picture would have appeared. Any images received as attachments remain unaffected.

STEP 1
From the **Inbox** window, click the **Preferences** link.

STEP 2
Under **General Email Preferences**, check the **Block images from external sources** box.

STEP 3
Click the **Save** button.

STEP 4
Click the **Close** button.

**AUTOMATIC SPELL CHECK**
The Spell Check functionality can be configured to automatically review all outgoing messages in the preferences area. When enabled, messages are checked whenever the **Send** button is clicked.

STEP 1
From the **Inbox** window, click the **Preferences** link.
STEP 2
From the **General Email Preferences**, check the **Spell Check all messages when sending** box.

STEP 3
Click the **Save** button.

STEP 4
Click the **Close** button.

RETURN RECEIPTS

STEP 1
From the **Inbox** window, click the **Preferences** link.

STEP 2
**Request Return Receipts**
From the **General Email Preferences**, check the **When sending mail, always request a return receipt** box to automatically request return receipts on sent mail.

**NOTE:** If this option is left unchecked, a return receipt can still be requested each time a message is composed by checking the **Request Return Receipt** box at the bottom of the **New Message** window.

STEP 3
**Process Return Receipts**
Next to **Receiving Return Receipt**, select an option to handle return receipt requests.

STEP 4
Click the **Save** button.

STEP 5
Click the **Close** button.
ACCOUNT SETTINGS

STEP 1
From the Inbox window, click the Preferences link.

STEP 2
Under General Email Preferences, click the account email address.

STEP 3
The account settings window enter the following:

A. In the Real Name field, enter the preferred name to display on all outgoing Emails.
B. In the Reply-To Address field, enter the Email address to display in the From line of outgoing Email.

NOTE: The Account Name cannot be changed.

STEP 4
Click the Save button.

STEP 5
Click the Close button.

EMAIL SIGNATURES

STEP 1
From the Inbox window, click the Preferences link.

STEP 2
In the Mail Preferences window click the Signatures link.

STEP 3
Click the New Signature button.

STEP 4
A. Under Signatures, enter a name for the signature.
B. Under Edit Signature Text, enter the signature.
STEP 5
Select additional desired options:

- The Make Default option is used to make the current signature the default when there are additional signatures created.
- The Automatically Insert Default Signature option is used to automatically add the default signature to all messages created.

STEP 6
Signatures can be also be edited:

- To edit text, click in the Edit Signature Text field, then make necessary changes.
- To rename the signature, click the Rename button.
- To delete the signature, click the Remove button.

STEP 7
Click the Save button.

STEP 8
Click the Close button.

MESSAGE FILTERS

STEP 1
From the Inbox window, click the Preferences link.

STEP 2
Under General Email Preferences in the Mail Preferences window, click the Filters link.

STEP 3
Click the Add button.

NOTE: Filters can also be created from the read mail window by clicking Options, then selecting Create Filter.
STEP 4
Enter the following information about the new filter, then click the OK button.
  • **Filter Title** — Enter a name for the filter
  • **Filter** — Enter the conditions for the filter to search, and how to search it
  • **Action** — Select the options to specify what to do with messages the filter finds

Click on **OK**.

STEP 5
Click the **Save** button to update the signature settings, or disable the filter by unchecking the box in the **Active** column. Click on **Save**.

STEP 6
Click the **Close** button.

VACATION MESSAGES

STEP 1
From the **Inbox** window, click the **Preferences** link.

STEP 2
Select **Vacation Message**.

STEP 3
Choose one of the following:
  A. Click the **On** button to forward messages to an alternate Email account.
  B. Click the **Off** button to disable **Vacation Messages** and Skip to Step 5.

STEP 4
  A. Select the **Reply only once** or **Reply each time** button.
  B. Enter the vacation message in the space provided.

STEP 5
Click the **Save** button.

STEP 6
Click the **Close** button.
MAIL FORWARDING

STEP 1
From the Inbox window, click the Preferences link.

STEP 2
Under General Email Preferences, select Mail Forwarding.

STEP 3
Choose one of the following:
   A. Select the On button to forward messages to an alternate account, or select Off to disable the mail forwarding feature and skip to step 4.
   B. In the Address field, enter the Email address to which messages should be sent.
   C. Select the Yes or No button to keep or delete messages in your original mailbox.

STEP 4
Click the Save button.

STEP 5
Click the Close button.
CONTACTS

Cox Business Email includes a contacts feature that stores and organizes contact information about individuals and groups.

ADD A NEW CONTACT

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.

STEP 2
Click on Add a new contact to the list icon. In new window, enter contact details.

STEP 3
Click the Save button.

STEP 4
Click the Close button.

EDIT CONTACTS

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.

STEP 2
Mouse over the contact to display the arrow button. Click on the arrow.

STEP 3
Click on Edit Details and revise contact details.

STEP 4
Click the Save button.
STEP 5
Click the Close.

GROUPS
Groups are another feature of Contacts that provide a convenient method of sending an Email message to a group of recipients.

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.

STEP 2
Click the Create New Group button to continue.

STEP 3
Enter a title in the Group Name field.

STEP 4
Enter a title in the Group Name field.
Contacts can be entered into the Add field in the following ways:
- Enter the contact information and matching entries display from the Contacts list.
- Drag and drop the contact from the Contacts list.
- Type the contact Email address in the Add field.

STEP 5
Click the Save button.

STEP 6
Click the Close.

EDIT GROUPS

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.
STEP 2
Mouse over the group to display the Contacts icon. Click on Contacts icon.

STEP 3
Click Edit Details to open the group details and revise contacts.

STEP 4
Click the Save button.

STEP 5
Click the Close.

IMPORT CONTACTS

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.

STEP 2
Mouse over the group to display the Contacts icon. Click on Contacts icon.

STEP 3
Highlight the desired address file and click the Open button. A confirmation message will display the number of imported contacts from the selected address file.

STEP 4
Click on OK.

SEARCH CONTACTS

STEP 1
From the Inbox window, click the Contacts button in the upper right corner of the screen.

STEP 2
Enter a partial or complete contact into the Search field.
**STEP 3**
Matching contact information displays in a drop down list. Click on the desired contact.

**STEP 3**
Click on the **STEP** button to clear the search field.

**DNS SETTINGS FOR COX BUSINESS EMAIL**
To use your Cox Business Email account, you’ll need to update the DNS settings to those listed below. Updating these settings will enable you to access the Internet and to send/receive Email. If you have questions, please contact your local customer care representative listed at the front of this guide.

<table>
<thead>
<tr>
<th>Primary</th>
<th>Secondary</th>
<th>Tertiary</th>
</tr>
</thead>
<tbody>
<tr>
<td>68.105.28.14</td>
<td>68.105.29.14</td>
<td>68.105.28.15</td>
</tr>
</tbody>
</table>
COX BUSINESS EMAIL ANTI-VIRUS SERVICE

Cox’s new Anti-Virus service helps defend your Cox Business Email account from hazardous computer viruses. The service is automatically activated and managed by Cox Business, and does not require any activation or action on your part.

HOW IT WORKS
Messages sent to Cox Business Email business Email accounts will be checked for viruses before being delivered to your inbox. If Cox Business Email Anti-Virus service detects a virus, one of the following actions will be taken:

- If an incoming Email contains an attachment with a known virus, then the infected attachment is deleted. However, the main body of the Email and any uninfected attachments will be sent to the Cox Business Email recipient along with an attached message indicating a virus was detected. No communication will be sent to the Email sender.
- If an incoming Email is infected within the body copy or has an infected attachment that cannot be deleted, the entire Email will be deleted without notification to recipient or sender.
- If an outgoing Email contains a known virus in the body of the Email or the attachment(s), the infected Email will not be sent to the intended recipient. No notification will be sent to the recipient or sender.

Please note that Cox Business does not read the content of your Email messages. This automated solution only detects known viruses.

Keep in mind that Cox Business Email Anti-Virus service only scans Email sent to and from Cox Business Email addresses. It does not scan or clean Email downloaded from a third-party ISP or other Email service. The Anti-Virus protection service also does not prevent a virus-infected file from being directly downloaded from the Internet, nor will it remove existing viruses from a computer.

TO REPORT A VIRUS NOT DETECTED AS A VIRUS
In the event you receive an Email that contains a virus that was not detected as a virus, you can send it to Cox Business for review. We will then work with our partners to ensure that this virus is detected in the future.

To submit an Email you suspect contains a virus from your Cox Business Email account, simply forward the suspected Email as an attachment to VirusReport@cox.net.
COX BUSINESS EMAIL SPAMBLOCKER
(JUNK EMAIL FILTERING)

SpamBlocker is Cox Business Email’s Anti-Spam service that helps guard users from unsolicited, time-wasting Email. Our Anti-Spam service automatically filters out outgoing spam, but does not automatically filter out incoming spam. Instead, our Anti-Spam service allows you to access the Web Services site to “turn on” the service and customize your level of protection. For additional information on how to protect your account from spam, go to the Customer Support section at cox.com.

SETTING UP SPAMBLOCKER (JUNK EMAIL FILTERING) FOR A COX BUSINESS EMAIL ACCOUNT

Setting up Junk Email Filtering is easy and quick to do. Remember, you can change the settings at any time. To get started, simply follow these steps.

Log into your Cox Business Email account, and select Preferences from the upper right. Click on the account on the left whose anti-spam option you would like to set and then click on Spamblocker.

Junk Email Filtering is defaulted to tag junk Email with “Spam” and deliver to your Inbox upon your registration to Cox Business Email. The other two anti-spam options are:

Delete incoming junk Email automatically — If this setting is selected, spam messages are deleted before the user ever sees them. Keep in mind that deleted Email cannot be recovered.

Deliver junk Email to the Cox Business Email Spam folder for later review. Messages in the Spam folder will be automatically deleted 21 days after receipt.

NOTE: Each Email address maintains separate anti-spam settings, so all users in an organization will need to set their options individually.
TO REPORT SPAM NOT DETECTED AS SPAM

In the event you receive an Email that SpamBlocker did not detect as spam, you can send it to Cox Business for review. We will then work with our partners to ensure that this type of unwanted Email is added to the list to be blocked.

To submit an Email as spam from your Cox Business Email account, select the message and click the Spam button in the toolbar.

This automatically moves the message into the Trash folder and reports it as Spam.

If SpamBlocker identifies an Email as spam but you believe it is not, you can use the Not Spam option to mark this message as not Spam. We will then work with our partners to ensure that this type of Email is not flagged in the future. This is known as a “false positive”.

To mark a message as Not Spam, select the message in the Spam folder, and click the Not Spam button in the upper right portion of the screen. A confirmation message appears. Click the Not Spam button to confirm the change and move the message to the Inbox folder.
CONFIGURING COX BUSINESS EMAIL ON MAIL CLIENTS

Instructions are provided to configure your Cox Business Email on Microsoft Windows or Apple Mail clients. For mobile phone configuration, please visit support.coxbusiness.com and select Data Support and click on Email.

POP vs. IMAP

POP is the recommended incoming mail server for customers who will mainly use a mail client like Outlook, Windows Live Mail and Apple Mail. For the use of a smartphone such as a Blackberry, an iPhone, or an Android phone to send and receive mail, then IMAP should be used.

SETTING UP MAIL IN OUTLOOK 2003

POP Configuration Instructions

STEP 1
From the Tools menu, select Email Accounts.

STEP 2
Select the Add a new Email account button and click on Next.

STEP 3
Select the POP3 button and click on Next.

STEP 4
Enter the Email account details and server Information:

- Incoming mail server (POP3) is pop.coxmail.com
- Outgoing mail server (SMTP) is smtp.coxmail.com
- User Name is the customer’s Email address
- Password

Click on More Settings.
STEP 5
On the **Outgoing Server** tab, select **My outgoing server (SMTP) requires authentication**, select the **Log on using button**, and enter the **User Name** and **Password**.

![Internet Email Settings](image)

STEP 6
On the **Advanced** tab, select **This server requires an encrypted connection (SSL)**, change **Outgoing server (SMTP)** to 465, and click on **OK**.

![Internet Email Settings](image)

STEP 7
Verify the information and click on **Next**.

STEP 8
Click on **Finished**.

**IMAP Configuration Instructions**
Follow the instructions for configuring POP, but replace steps 3, 4 and 6 with the following:

STEP 3
Select the **IMAP** button and click on **Next**.

STEP 4
Enter the Email account details and server Information:
- **Incoming mail server (IMAP)** is imap.coxmail.com
- **Outgoing mail server (SMTP)** is smtp.coxmail.com
- **User Name** is the customer’s Email address
- **Password**

Click on **More Settings**.
STEP 6
On the Advanced tab, select both instances of This server requires encrypted connection (SSL), change Incoming server (IMAP) to 993, change Outgoing server (SMTP) to 465, and click on OK.
SETTING UP MAIL IN OUTLOOK 2007

POP Configuration Instructions

STEP 1
From the Tools menu, select Account Settings.

STEP 2
Select the Email tab and click on New.

STEP 3
Select Manually configure server setting or additional server types. Click on Next.

STEP 4
Select Internet Email and click on Next.

STEP 5
Enter the Email account and server details:
- Account Type is POP3
- Incoming mail server is pop.coxmail.com
- Outgoing mail server is smtp.coxmail.com
- User Name is the Email address
- Password
Click on More Settings.

STEP 6
Under the Outgoing Server tab, select My outgoing server (SMTP) requires authentication. Select Log on using and enter the log on details.
STEP 7
Under the Advanced tab, change:

- **Outgoing server (SMTP) is 465**
- **Select SSL from the Use the following type of encrypted connection drop-down list.**

Click on **OK**.

STEP 8
Click on **Next**.

STEP 9
Click on **Finish**.

**IMAP Configuration Instructions**
Follow the instructions for configuring POP, but replace steps 5 and 7 with the following:

STEP 5
Enter the Email account and server details:

- **Account Type** is **IMAP**
- **Incoming mail server** is **imap.coxmail.com**
- **Outgoing mail server** is **smtp.coxmail.com**
- **User Name** is the Email address
- **Password**

Click on **More Settings**.

STEP 7
Under the Advanced tab, change:

- **Incoming server (IMAP) to 993**
- **Outgoing server (SMTP) to 465**
- **Select SSL from the Use the following type of encrypted connection drop-down list for both incoming and outgoing servers**

Click on **OK**.
SETTING UP MAIL IN OUTLOOK 2010

POP Configuration Instructions

STEP 1
Click the File tab. Under Account Information, click on Add Account.

STEP 2
Select Manually configure server settings or additional server types. Click on Next.

STEP 3
Select Internet Email and click on Next.

STEP 4
Enter the Email account and server details:
• Account Type is POP3
• Incoming mail server is pop.coxmail.com
• Outgoing mail server is smtp.coxmail.com
• User Name is the Email address
• Password
Click on More Settings.

STEP 5
Under the Outgoing Server tab, select My outgoing server (SMTP) requires authentication. Select Log on using and enter the log on details.

STEP 6
Under the Advanced tab, change:
• Outgoing server (SMTP) is 465
• Select SSL from the Use the following type of encrypted connection drop-down list
Click on OK.
STEP 7
Click on Next.

STEP 8
Click on Finish.

IMAP Configuration Instructions
Follow the instructions for configuring POP, but replace steps 4 and 6 with the following:

STEP 4
Enter the Email account and server details:

- **Account Type** is IMAP
- **Incoming mail server** is imap.coxmail.com
- **Outgoing mail server** is smtp.coxmail.com
- **User Name** is the Email address
- **Password**

Click on More Settings.

STEP 6
Under the Advanced tab, change:

- **Incoming server (IMAP)** to 993
- **Outgoing server (SMTP)** to 465
- **Select SSL** from the **Use the following type of encrypted connection** drop-down list

Click on OK.
SETTING UP MAIL IN MICROSOFT OUTLOOK EXPRESS

POP Configuration Instructions

In the Internet Accounts screen select the Add button, then Mail.

STEP 1
Open Outlook Express.

STEP 2
From the Tools menu, select Accounts.

STEP 3
Click Add and select Mail.

STEP 4
Enter the customer’s name and click on Next.

STEP 5
Enter the customer’s Email address and click on Next.

STEP 6
Enter the following server information:
• In the My incoming mail server is a drop-down list, select POP3
• Incoming mail server is pop.coxmail.com
• Outgoing mail server is smtp.coxmail.com

Click on Next.
STEP 7
Enter the **Account name** and **Password** and click on **Next**.

**NOTE:** Enter the entire Email address including the @address.com portion of your **Account name**.

STEP 8
Click the **Finish** button.

STEP 9
Highlight the pop.coxmail.com account and click on **Properties**.

STEP 10
On the **Servers** tab, select **My server requires authentication**. Click on **Settings**.

STEP 11
Select **Log on using** and enter the **Account name** and **Password**. Select **Log on using Secure Password Authentication**. Click on **OK**.

STEP 12
On the **Advanced** tab, complete the following:
- Enter **465** in the **Outgoing mail (SMTP)** field.
- Select **This server requires a secure connection (SSL)**.

**IMAP Configuration Instructions**
Follow the instructions for configuring POP, but replace steps 6, 9 and 12 with the following:

STEP 6
Enter the following server information:
- In the **My incoming mail server is a drop-down list**, select **IMAP**
- Incoming mail server is **imap.coxmail.com**
- Outgoing mail server is **smtp.coxmail.com**

Click on **Next**.
STEP 9
Highlight the imap.coxmail.com account and click on Properties.

STEP 12
On the Advanced tab, complete the following:

• The port for **Outgoing mail (SMTP)** is 465
• The port for **Incoming mail (IMAP)** is 993
• Select **This server requires a secure connection (SSL)** for both outgoing and incoming servers
SETTING UP MAIL IN MICROSOFT WINDOWS MAIL

POP Configuration Instructions

STEP 1
In Windows Mail, click the Tools menu and select Accounts.

STEP 2
Click Add.

STEP 3
Select Email Account and click on Next.

STEP 4
Enter the account details and click on Next.

STEP 5
Enter the Email account details and click on Next.

STEP 6
• Select POP3 in the Incoming Email server type drop-down list
• Incoming mail is pop.coxmail.com
• Outgoing mail is smtp.coxmail.com
• Select Outgoing server requires authentication

Click on Next.

STEP 7
Enter the Email username (Email address) and password and click on Next.

STEP 8
Click Finish.
STEP 9
Select the Cox Business Email account and click on Properties.

STEP 10
On the Servers tab, under Outgoing Mail Servers, click Settings.

STEP 11
Select the Log on using button. Enter the customer's log on information and click on OK.

STEP 12
• On the Advanced tab, ensure that the ports are correct.
• Outgoing mail is (smtp) is 465
• Select This server requires a secure connection (SSL)
Click on OK.

IMAP Configuration Instructions
Follow the instructions for configuring POP, but replace step 6 and 12 with the following:

STEP 6
Enter the following server information:
• Select IMAP in the Incoming Email server type drop-down list
• Incoming mail is imap.coxmail.com
• Outgoing mail is smtp.coxmail.com
• Select Outgoing server requires authentication
Click on Next.
STEP 12

- On the Advanced tab, ensure that the ports are correct.
- Outgoing mail (SMPT) is 465
- Incoming mail (IMAP) is 993
- Select This server requires a secure connection (SSL) for both incoming and outgoing mail.

Click on OK.
SETTING UP MAIL IN MICROSOFT WINDOWS LIVE MAIL

POP Configuration Instructions

STEP 1
In Windows Live Mail, click the Tools menu and select Accounts.

STEP 2
Click Add.

STEP 3
Select Email Account and click on Next.

STEP 4
Enter the Email account details. Click Next.

STEP 5
Enter the Email account and server details:
- Select POP3 in the My incoming mail server is a drop-down list
- Incoming server is pop.coxmail.com
- Login ID is the Email address
- Outgoing server is smtp.coxmail.com
- Select This server requires a secure connection (SSL)
- Select My outgoing server requires authentication

Click on Next.

STEP 6
Click Finish.
IMAP Configuration Instructions
Follow the instructions for configuring POP, but replace step 5 with the following:

**STEP 5**
Enter the following server information:

- Select **IMAP** in the *My incoming mail server is a drop-down list*
- **Incoming server** is `imap.coxmail.com`
- **Login ID** is the Email address
- **Outgoing server** is `smtp.coxmail.com`
- Select **This server requires a secure connection (SSL)** for both the
  Incoming and Outgoing servers
- Select **My outgoing server requires authentication**

Click on **Next**.
SETTING UP MAIL IN APPLE MAIL

POP Configuration Instructions

STEP 1
Open Apple Mail. From the File menu, select Add Account.

STEP 2
Enter the Cox Business Email account information and click on Continue.

STEP 3
Enter the following mail server information:
• Account Type is POP
• Enter a Description for the server
• Incoming Mail Server is pop.coxmail.com
• User Name is the full Email address
• Password
Click Continue.

STEP 4
Enter the following outgoing mail server information:
• Enter a Description for the server
• Outgoing Mail Server is smtp.coxmail.com
• Select Use Authentication
• User Name is the full customer’s full Email address
• Password
Click Continue.

STEP 5
Review the account details and click Create.

STEP 6
From the Mail menu, select Preferences.
STEP 7
On the Accounts tab, select the Cox Business Email account in the Accounts list on the left.

STEP 8
Also on the Accounts tab, select Edit Server List from the Outgoing Mail Server (SMTP) drop-down list.

STEP 9
From the Advanced tab:
• Select Use default ports (25, 465, 587)
• Select Use Secure Sockets Layer (SSL)
• From the Authentication drop-down list, select Password
• Enter the User Name and Password

Click OK.

STEP 10
Click on Save.

IMAP Configuration Instructions
Follow the instructions for configuring POP, but replace step 3 and follow additional steps after step 7:

STEP 3
Enter the following mail server information:
• Account Type is IMAP
• Enter a Description for the server
• Incoming Mail Server is imap.coxmail.com
• User Name is the full Email address
• Password

Click Continue.
FOLLOWING STEP 7
From the Advanced tab, enter the following:

- Port is 993
- Select Use (SSL)
- From the Authentication drop-down list, select Password
Cox Business Email Customer Control Panel is a special feature for Cox Business Internet users that enables the administrator to manage a company’s Email accounts at his or her convenience. The features and functionality of your Email boxes remain unaffected while allowing the administrator to:

- Manage existing Email boxes.
- Allocate total storage unequally across existing Email boxes.
- Add additional Email addresses.
- Send an Email request to purchase more Email boxes and storage.
- Send Email requesting assistance.

The following pages will walk you through several of the Control Panel features. If you need to set up your company’s Email administrator or have any questions, please contact us at support@coxmail.com. Your customer care representative will contact you within 48 hours.

To begin first go to http://control.coxmail.com.

ASSIGNING EMAILBOXES
To set up new Emailbox accounts simply follow these instructions.

STEP 1
Go to the User Management page. Here you will find a listing of existing Emailbox users and notation of how many available e-mailboxes you currently have. If there are e-mailboxes available, clicking that notation will take you to the New Emailbox page.
STEP 2
Enter the user’s new Emailbox address.

NOTE: The username must be between 3 and 32 characters, and can contain letters and numbers. They may include a dash (-), underscore (_), or a period (.). And usernames are not case sensitive.

STEP 3
Fill in user’s First Name and Last Name in the corresponding fields.

STEP 4
Set the storage allocation. You can also set or adjust the storage allocation at any time by visiting the Storage Allocation page.

STEP 5
Assign the user’s password. The password should be at least 6 characters in length, and can be alphanumeric.

STEP 6
Re-enter the password to confirm.

STEP 7
Click the Submit Changes button to execute the operation.

NOTE: It may take up to 15 minutes for this new Emailbox to become active.

DELETING EMAILBOXES
If you need to delete an Emailbox, simply go to the User Management page and check the box under the Delete Emailboxes heading that corresponds to the box you wish to delete. Then click the Submit Changes button to execute.

If you are logged in as an administrator to control.coxmail.com, you must call Cox Business Support or create a new admin Email. Then, log into the control panel under the new address before deleting the administrator account.
NOTE: If the user is also designated as an administrator, you need to uncheck the Admin box prior to submitting the changes.

MAKING CHANGES TO EMAILBOXES
To make changes to an existing Emailbox account, follow these instructions.

STEP 1
Go to the User Management page, and click on the Emailbox you wish to edit.

STEP 2
The Edit Emailbox page allows you to make changes to the username and password. To change the username, fill in the First Name and Last Name in the corresponding fields.

STEP 3
To re-set the password, fill in the new password in the Assign Password field and then Re-Enter Password to confirm changes.

STEP 4
Click the Submit button to execute.

REQUESTING ADDITIONAL EMAILBOXES AND/OR STORAGE
If your company has used all your Emailboxes or needs additional storage, then you must request additional mailboxes using the Request Additional Emailboxes/Storage form or calling a customer care representative. To request Emailboxes or storage online, follow these basic instructions:

STEP 1
On the User Management page, click on the Request Additional Emailboxes/Storage link in the Support & User Guide section. This will take you to an online form that allows you to request additional Emailboxes and/or storage. Be sure to include a method of contact and accurate contact information.
STEP 2
Click the Submit button to execute your request.

NOTE: A customer care representative will respond to your request within 2–3 business days. If you would like to acquire Emailboxes or storage more quickly, call your local customer care representative.

ASSIGNING ADMINISTRATOR PRIVILEGES
If you are currently an administrator for your company and would like to assign administrator privileges to an additional user, go to User Management and click on the Assign Admin checkbox that corresponds to that user. Click the Submit Changes button to execute.

MAKING CHANGES TO USERS EMAILBOX STORAGE
To change the storage allocation of specific users in your company go to the Storage Allocation page. Here you can specify new allocations in the New Allocation box corresponding to the specific user. Click the Submit button to execute the changes.

NOTE: The allocation cannot be set lower than the currently used allocation. Also, the lowest that a new allocation amount can be set is calculated by rounding currently used allocation up to the nearest MB, then adding an additional 1MB.
TECHNICAL SUPPORT
AND TROUBLESHOOTING

Your cable modem will operate continuously without maintenance. The cable modem should remain powered whether your computer is on or off. If you do experience a problem, there are a few basic troubleshooting steps you can take that often corrects the problem. These steps are outlined below. If, after attempting the troubleshooting remedies, the problem persists, contact Cox Business customer care by telephone at the phone numbers listed at the front of this guide.

- **Check the coaxial cable at the modem and the outlet.** If the connection on your coaxial cable becomes loose either at your modem or at the cable outlet, you will not be able to send or receive data. Secure the connection.
- **Check the network cable at the modem and the computer.** If the connection on your network cable becomes loose either at your modem or at your computer, you will not be able to send or receive data. Secure the connection.
- **Reset the modem.** Some cable modems have a reset button that can be pressed to reset. If yours does not, reset the modem by unplugging the power cable from the wall and plugging it back in.
- **Check Windows or Macintosh configuration.** See the TCP/IP Setup instructions in this guide and check that all settings are correct.

ACCEPTABLE USE POLICIES

All services provided by Cox Business, including Data, Internet, Cox Business Email, Web Hosting and Webconferencing Services (“Services”), are subject to the terms and conditions of the Acceptable Use Policies (AUPs). In addition, this document contains Cox’s IP Address Policy with respect to those Services. Use of any of these Cox Services shall at all times be subject to the terms and conditions of these AUPs. Web hosting customers may view their AUP by clicking on the control panel. The AUPs may be amended from time to time during the term of this agreement. Customer’s continued use of the services following an amendment shall constitute acceptance. Cox is not responsible for the networks or facilities of third parties, which may be necessary to provide service. To view the Cox Business Acceptable Use Policies, please go to [http://www.coxbusiness.com/AcceptableUsePolicy.pdf](http://www.coxbusiness.com/AcceptableUsePolicy.pdf) and click on the Acceptable Use Policies link in the left-hand column.